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VFD Tube Clock with ESP32 DevKit-C
Assembly Manual

Revision 3

This kit is designed for someone who has intermediate experience with assembling electronics.
This is not a beginners electronics kit and requires knowledge of soldering, programming Arduino
and a good grasp of basic electronics.

Please take your time — it will take approximately four hours to complete this kit. Ensure your work
area is well lit (daylight preferred) and clean.

Assemble the parts in the order as stated in the instructions. Read and understand each step
before you perform each operation for the best chance of success.

The following tools and materials will be required to assemble the clock:
* A good quality soldering iron (25-40W) with a small tip (2-3 mm).

* Thin solder wire with no-clean flux. Do not use any flux or grease.

* A set of small screwdrivers.

* A small wire cutter for electronics.

* A wire stripper.

* Long nose pliers.

* A hot air soldering station / heat gun / lighter (or alternative).

* A multimeter.

* A computer with the Arduino IDE and Arduino Core for ESP32 installed.

Reading the entire manual before starting the project is highly advised and will help you
comprehend the overall project.

This manual is written for clock software dated 2018-05-27.

Disclaimer: All pictures are for illustration purposes only. Actual product may vary due to product
enhancement.
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Schematic and PCB Layout

Main PCB
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Display PCB
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Backlight PCB
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Assembling the Display PCB

Assembly instructions for DM 160 tubes or equivalent (as supplied with the kit):
¢ Mount resistors R1 and R2, 3.3 Q.
* Mount resistors R3A and R4A, 100K (leave R3B and R4B open).

Assembly instructions for Russian IV-15 tubes (not supplied with the kit):

* Mount resistors R1 and R2, 6.8 - 10 Q.

* Mount resistors R3B and R4B, 100K (leave R3A and R4A open). We didn't try this out in real life,
some experimentation with the value of R1 and R2 may be necessary. Further in this manual we
assume you use DM160 tubes. Values and results may differ somewhat when using IV-15 tubes.

When we use the term “DM160 tube”, this also refers to equivalent tubes like the CV5412, CV6094
and 6977 and possibly other compatible types.

Now mount the angled pin headers K1, K2 and K3.

Page 6 of 38



-
?? 22
o " %
t 2 g
'\, ) - A
i
¥
2o
P A
% ) N
~ k. \
- - \
N \
< \\ N

Cut two pieces of the 6.4 mm heat shrink tube with the same length as the 14 mm aluminum
spacers.

Carefully remove the fuse holders from the paper <,
strip without cutting the leads. You will notice %% 72
that the leads are somewhat wider at the ends. 4 \
Trim the ends longitudinally with a sharp wire W

cutter so the leads have an uniform width.

Place an aluminum spacer between the leads of the fuse holder and slide the heat shrink tube over
the aluminum spacer and the leads of the fuse holder. Crimp the heatshrink tube and carefully
remove the small metal tab from the fuseholder itself with a wire cutter so the DM160 tube will fit.

Mount the fuseholder assemblies to the front side of the display PCB.
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UKEYSIGHT  U1241C True AMS Muttimer

Cut eight 22 mm length pieces of the 1.6 mm heat shrink tube. Slide them over a thin piece of
wire, a lead of a resistor or something similar and shrink them using a heat source.

When you look at the bottom side of the
DM160 tube you will see four wires. Three of
them are in a single row and close to each
other. The fourth wire is somewhat separate
from the other three. This is also reflected on
the display PCB to make mounting of the
tubes easier.

Front View
Filament

Filament

Slide the pre-shrinked heat shrink tubes over the leads of the DM160 tubes (TU7 and TU8) and
bend the leads at an angle of 90 degrees (at a distance of approximately 5 mm of the tube
bottom). Slide the leads through the holes of the PCB and press the tubes into the fuse holders.
Make sure the front of the tubes is facing forwards and finally solder and clip the leads.

Measure the resistance between pin 7 and 8 of K2 with a multimeter. The resistance should be
around 6 ... 6.5 Q or slightly more depending on the resistance of the test leads. This is an
indication that the DM160 tubes are mounted correctly.
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Have the IV-22 tubes and tube socket pins ready for the next step. Before starting the assembly
you can put the IV-22 tubes temporarily on the PCB to see in which order they look best. 1V-22
tubes have quite some tolerances, especially concerning mechanical dimensions and background
color of the 7-segment digit.

Take a look at the tubes. Normally the getter on the side of the tube should look dark with a silvery
shine. If it's white, air has entered the tube and you should discard the tube as it will not work
anymore.

Pinch the tube socket pins between your fingers so they will be more tight. In order to mount the
tubes, you can choose between two options. You can either slide the tube socket pins over the
pins of the tube and push the tube with socket pins through the holes of the PCB or fit the tube
socket pins to the PCB and push the tubes in the socket pins. If you choose the latter option, make
sure the pins of the tubes are correctly seated into the socket pins.
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When all the tubes are in place, turn over the PCB and solder the tube socket pins from the
backside. Do not use too much solder and keep soldering time short.

Finally measure the resistance between pin 7 or 8 of K2 (filament connections) and all the other
pins on K1, K2 and K3. If everything is ok, you shouldn't be able to measure any resistance (open
circuit) between any of the pins and the filament connections. If you measure a resistance one of
the IV-22 tubes has a production fault or is mounted upside down.

The display PCB is now finished.
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Assembling the Main PCB

Mount the components from low to high. Start
with the horizontally mounted resistors R5 (330
Q), R14 ... R16 (4K7) and R17 (10K). Then mount
the diodes D1, D2 (1N4007), D3 (MUR160G) and
D4 (1N5819). Finally mount C1 (330 pF).

Mount the IC sockets for IC2 (8p) and IC3 (40p).
Mount the DC/DC step-down converter module
IC1 (PTHO8080WAH). Keep the soldering time as
short as possible.

Mount the trim potentiometers P1 (4K7) and P2
(47K) and capacitors C2, C3 (100 nF). The trim
potentiometers should be in middle position.

llu,ullmullul

B i

Mount the angled locking headers K6 (3p) and K7 (4p). Finally mount zener diode D5 (1N5347BG).
Make sure there is a space of a few millimeters between the PCB and D5 as this component may
get very hot during fault conditions (overvoltage, wrong polarity).

Mount the resistors R1 ... R4 (100 Q), R6 (2K2),
R7 (3K3), R8 ... R13 (4K7), R18 ... R20 (27K),
R21 ... R24 (100K) and R25 (220K) in an upright
position.
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Mount the socket headers K1 ... K3 (2x5p), K8
(1x4p) and MOD1 (ESP32-devkitC, 2 x 1x20p).

Mount the transistors with T092 case T1
(BC574B) and T3 ... T9 (2N7000). Mount them so
the top of their casings is flush with the top of
the socket headers. This makes mounting easier.

Finally mount the larger components. Start with
C6 ... C8 (220 uF). Then mount the terminal
blocks K4 and K5. Mount the 5V DC/DC step-
down converter 1C4 (Wirth 173019578). Mount
polyfuse F1 (500 mA), L1 (47 pH 1.2A), C4 (4.7 uF
100 V) and C6 (100 pF).

Finally mount MOSFET power transistor T2
(IPP200N15N3 G). Please note there is currently
(April 2018) a shortage of these transistors. We
may substitute this transistor in our kits with
another type MOSFET at our discretion. This will
in no way alter the functionality of the clock.

Place IC2 (ICM7555) in its socket and connect
GND and pin 8 (I033) on the ESP32-devkitC
socket with a piece of jumper wire (not included
with the kit).
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Power up the bord using a 9 V power supply
capable of delivering at least 500 mA. Measure
the voltage between pin 20 (-) and pin 40(+) of
the IC socket of IC3. The voltage should be
approximately 5 V.

Now measure the grid/anode voltage between
pin 1 (+) and pin 20 (-) of the same IC socket.
Adjust this voltage to approximately 50 V using
trim potentiometer P1.

Finally measure the voltage between pin 2 (-) and
pin 3 (+) of IC1 (PTHO8080WAH). You can also
measure this voltage on K2. Do not measure this
voltage in reference to ground (GND) ! Now
adjust the voltage to approximately 1.1 V using
trim potentiometer P2.

Do not continue assembling the clock if the

voltages are not correct but look for assembling
faults instead.

If everything is ok, disconnect the power supply.
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Assembling the RGB Backlight PCB

Mount the 330 Q resistors R1 ... R18 on the backside of the PCB.

Mount the RGB LEDs on the front side of the PCB. Watch the polarity, the flat side of the LED goes
where the PCB symbol is marked with a dash. Push the LEDs through the holes until they don't go
any further.

Be careful not to overheat the LEDs while soldering them in place. Solder one lead of each LED first
and check the alignment. Then solder the remaining leads.

o 3

Connect two 4 pole pin headers together using 5 cm of white, red, green and blue wire. Insulate
the solder joints using 1 cm 3.2 mm heat shrink tube.
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Solder 1 side to the RGB backlight PCB, so that
the wires protrude from the backside. The white
wire goes to the solder pad marked with +5 V. If
you wish, you can test the LEDs using a 5 V (lab)
power supply.
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Final Assembly Steps

Connect the display PCB to the main PCB. Power up the main PCB and take a look at the VFD tubes
in a dark room. The filaments of the tubes should glow dimly with a dark red color. If the filament
of an IV-22 tube does not glow or very faint compared to the other tubes, wriggle the tube a bit
back and forth in the socket pins until the filament glows properly. Sometimes there is a bad
contact between the IV-22 tube pins and the socket pins on the PCB due to a thin layer of
oxidation. Given the very low filament voltage of 1.1V, this can be problematic.
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Place 1C3, HV518P in its socket. Remove the
jumper wire between GND and pin 8 (1033) of
the ESP32-devkitC headers. Fit the ESP32-devkitC
module into the socket headers. The socket
headers are 20 way while the pin headers on the
ESP32-devkitC have only 19 pins, so be very
careful to fit the ESP32-devkitC correctly into the
socket headers. We opted for 20 way socket
headers as 19 way socket headers are difficult to
get or even require custom manufacturing which
is very costly.
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Z
Mount two 15 mm hex standoffs to the RGB backlight PCB using 2 M3 x 6 machine screws and 4

M3 nylon washers.
Attach the RGB backlight PCB to the display PCB using 2 M3 x 6 machine screws and 4 M3 nylon
washers. Connect the RGB baclight PCB cable to K8 on the mainboard. Be sure to use the right

orientation.
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Setting up the Software

This section is for the most part aimed at using the Arduino IDE in Windows 7. You should have no
problem when using another version of Windows or any other operating system that's supported

by the Arduino IDE.

Serial Interface

Power up the clock and connect the ESP32-devkitC with a PC using a USB cable. The ESP32-devkitC
incorporates a USB-to-serial function that enables the PC to access the clock as a serial interface.

If you're using Linux, the system will create an entry in the device directory structure e.g.
/dev/ttyUSBO. Run command Isusb to obtain a list of all connected USB devices.

A Computer Management

=

File Action View Help
e @ EIHE 8BRS

4 5 Peter-HP
M Computer
' Disk drives
- Display adapters
+ ey DVD/CD-ROM drives
- £ Human Interface Devices
» g IDE ATAJATAPI centrollers
== Keyboards
Il Mice and other pointing devices
i Monitors
¥ Network adapters
15" Ports (COM & LPT)
13" Communicatiens Port (COML)
L 5" Silicon Labs CP210x USB to UART Bridge (COM4)
n Processors
» [ Security Devices
..% Sound, video and game contrellers

[N

, {8 System devices
§ Universal Serial Bus contrallers

A Computer Management | =ARE X
File Action Wiew Help
L AReale SN P Rl A
2} Intel(R) Core(TM) i3-6100 CPU @ 3.70GHz -

2} Intel(R) Core(TM) i3-6100 CPU @ 3.70GHz
2} Intel(R) Core(TM) i3-6100 CPU @ 3.70GHz
-8 Microsoft Windows Management Interface for ACPL
-8 Microsoft Windows Management Interface for ACPL
-~ Micresoft Windows Management Interface for ACPL
4 {8 PClbus
+-78 High Definition Audio Controller
+ g Intel(R) 100 Series/C230 Chipset Family SATA AHCT Controller
78 Intel(R) 100 Series/C230 Series Chipset Family LPC Controller - A147
78 Intel(R) 100 Series/C230 Series Chipset PMC - A121
78 Intel(R) 100 Series/C230 Series Chipset SMBus - A123
78 Intel(R) 100 Series/C230 Series Chipset Thermal subsystem - A131
l,_? Intel(R) Ethernet Connection (2) 219-LM
- B Intel(R) HD Graphics 530
41§ Intel(R) USE 3.0 eXtensible Host Controller
4§ Intel(R) USE 3.0 Root Hub |
L. Silicon Labs CP210x USB to UART Bridge (COM4)
5 05 USB Input Device ad
i

If you're using Windows, the operating system will assign a COM-port. A serial port is typically
named COM<x> where <x> is a number between 1 and 256. You can observe the COM-port in the
device manager. When the devices are displayed by type, the COM-port appears under the “Ports
(COM & LPT)” branch. You can select to view devices by connection which renders a tree structure.

Clock Software

The clock software is an Arduino sketch. We used Arduino IDE v1.8.5 for developing and testing
the software. The source code is made up of .ino files. You find many useful remarks and comment
blocks in these source files.

Besides the IDE you need to install the Arduino core for the ESP32. This package adds support for
ESP32 to the Arduino IDE. Currently, this package can be downloaded from GitHub:

https://github.com/espressif/arduino-esp32

This link will show you the main page of the software package. The page contains installation
instructions.
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There is a catch. We took a snapshot on October 6" 2017 and used it successfully during the
development of the sketch. However, at this time of writing, the software package on GitHub won't
work. We hope this situation will change very soon. Anyways, the snapshot we used is available
and will work if you install it now.

There are two ways of putting the clock software in the ESP32-devkitC:
* Use esptool to upload the binary files.
* Upload from within the Arduino IDE.

Either way you need to install Arduino IDE and the Arduino core for the ESP32.

To upload the binary files using esptool, first put all binary files in a directory, and then invoke the
following command from the command prompt in that directory:

bin> path-to-esp32-tools\esptool.exe --chip esp32 --port COM4 --baud 921600 --before
default reset --after hard reset write flash -z --flash mode dio --flash freq 80m
--flash size detect 0xe000 boot app0O.bin 0x1000 bootloader gio.bin 0x10000

vfd clock wifi.ino.bin 0x8000 vfd clock wifi.ino.partitions.bin

Replace bin with the path to the directory that contains the binary files. Replace path-to-
esp32-tools with the path to the tools directory in the Arduino core for the ESP32. For
example:

C:\Users\Peter\Documents\Arduino\hardware\espressif\esp32\tools

The esptool will output information like this:

esptool.py v2.1

Connecting........ o

Chip is ESP32DOWDQ6 (revision O0)

Uploading stub...

Running stub...

Stub running...

Changing baud rate to 921600

Changed.

Configuring flash size...

Auto-detected Flash size: 4MB

Compressed 8192 bytes to 47...

Wrote 8192 bytes (47 compressed) at 0x0000e000 in 0.0 seconds (effective 4096.0
kbit/s) ...

Hash of data verified.

Flash params set to 0x022f

Compressed 12384 bytes to 8181...

Wrote 12384 bytes (8181 compressed) at 0x00001000 in 0.1 seconds (effective 792
6 kbit/s)...

Hash of data verified.

Compressed 508016 bytes to 328749...

Wrote 508016 bytes (328749 compressed) at 0x00010000 in 5.7 seconds (effective
17.7 kbit/s) ...

Hash of data verified.

Compressed 3072 bytes to 122...

Wrote 3072 bytes (122 compressed) at 0x00008000 in 0.0 seconds (effective 1638.
kbit/s) ...

Hash of data verified.

Leaving...
Hard resetting...
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After this, the clock is ready to be set up as described further.

The other way of uploading the clock software to the ESP32-devkitC module is using the Arduino

IDE.

: - L 2 ___ 3 SIS
The source code consists of multiple .ino : i
. . . . @[ | < vfd_clock_wifi 201802 08 » vfd_clock_wifi w43 W search vid_clock wifi 2|
source files. The main file is called 6o Rl =
e o . Organize » || Open Burn New folder * [ @
vfd_clock_wifi.ino, it has the same name e o r—
(without .ino) as the containing folder. - Ele Bl
i e Diesino
’ || main.ino | ntp.ino
| ewino || ewtempine
Open vfd_clock_wifi.ino in the Arduino IDE Llrgbine Lsstshino
| settingsing || tokenizering
to open up the Sketch. The IDE shows all Dtsivo it

[ wifi.ino

files in tabs, starting with the main file and

followed by the other files in the folder vid_clock wifiino Dete modified: 8/02/2018 17:10

ING File

sorted alphabetically.

Size: 159 KB

Date created: 9/02/2018 13:25

-

% vid_clock_wifi | Arduino 1.8.5

Eile Edit Sketch Tools Help

cmd_proc

cmd_server display

serial

ESP32 Dew Madule, Default, QI0, BIMHz, 4MB (32Wb]

0, None on COM<

The sketch required the following libraries: Wire (for access to 12C), EEPROM, WiFi, and Time. If

any of these libraries is missing, YT

S

open the library manager (menu || ..a =] rovc (e e v

Sketch -> Include Library -> Manage

Tic by Pololu

L| b ra r| es.. _) a nd |n Sta I I th em |SS| ng Tic Stepper Motor Controller library for Arduine This is 2 library for the Arduino IDE that helps intarface with = Tic Stepper Motor

Controller. It communicates with a Tic using serial or 12C.
Mere infe

pieces. If multiple versions of a

library are available, use the latest | i comioaes oo o0 memaien
one. The picture to the right shows | g unen=.
the Time library in the Library

Timekeeping functionality for Arduino Date and Time functions, vith provisions to synchronize to external time sources like GBS

TimeAlarms by Michael Margolis

M a nage r. VerS|0n 1,5.0 Of the T|me Perform tasks at specific times or after specific intervals. The Alarm library is a companion to the Time library that makes it
=asy to perform tasks at specific times or after specific intervals. Tasks scheduled at a particular time of day are called Alarms,
tasks scheduled after an interval of time has lapsed are called Timers. These tasks can be created to continususly repeat or to

library was installed directly from | o2
this window. Other required

mn

libraries can be found here as well.

Close

Page 21 of 38



vid_clock wifi | Arduine 1.85

File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch

vid_tlock_wif Fix Encoding & Reload

Serial Monitor Ctrl+5Shift+M
Serial Plotter Ctrl+Shift+L

WiFi101 Firmware Updater

Board: "ESP32 Dev Module”
Flash Mode: "QIO"

Flash Frequency: "80MHz"
Flash Size: "4MB (32Mb)"
Partition Scheme: "Default”
Upload Speed: "921600"
Core Debug Level: "None"
Port: "COM4"

Get Board Info

Programmer: "AVRISP mkIl" 4

Burn Bootloader

Before you start building the sources, you've to set up the IDE for use with the ESP32-devkitC
module. In the Tools menu, select board type “ESP32 Dev Module” and select the COM-port
assigned to your clock.

vid_clock wifi | Arduino 18.5 pra— _— -__LEI—‘ml

File Edit Sketch Tools Help

vid_clock_wifl

[

S

- o

Now you can build and upload the software. In the Arduino IDE, this process is simply called
“Upload”. Select menu Sketch -> Upload, or press CTRL-U to proceed.

If you get compiler warnings or the build process stops because of warnings, select menu File ->
Preferences -> Settings tab and set “Compiler Warnings” to “None”.
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vid_clock wifi | Arduine 1.85

File Edit Sketch Tools Help

cmd_proc cmd_server display dns Im75 main

owtemp

ES

rgh serial seftings

P32 Dev Module, Default, QI

After the IDE has successfully uploaded the binary to the ESP32-devkitC, the clock sends text to the
serial interface. You can observe this information in the IDE's serial monitor. Select menu Tools ->
Serial Monitor, or press CTRL-SHIFT-M to open up the serial monitor. Set the baudrate to 115200
and select something different from "no line ending".

IMPORTANT! Each time you open the serial interface, the board will reset. This behavior is
specified by Arduino and occurs with all Arduino-compatible boards, independent of operating
system and serial monitor program (Arduino IDE's serial monitor, PuTTY, netcat, ...). So beware,
when you change settings, then close and reopen the serial interface before writing the settings to

non-volatile memory (a.k.a. EEPROM), the changes will be lost.

com4

L = O =)

B
You can send commands to the clock from the |
serial monitor. For example, command s d (a short  |s=s::
. . . * 8SID:
version of settings dump) reports a list of all ||+ tocai:  0.0.0.0
. * Subnet: 0.0.0.0
current Settlngs' * Gateway: 0.0.0.0
* DNS 1: 0.0.0.0
* DNS 2: 0.0.0.0
At this point, no settings are set, unless you're ||* method: dynamic

ESP32-devkitC was already set up for the clock. To
fill in the settings, you've to send a series of
commands. You can manually type each command
in the serial monitor. This will take time, so let's
use a better method.

You can put the commands in a text file and send
its contents to the serial port. Since the serial
monitor in the Arduino IDE isn't capable of
sending a file or pasting multiple lines from the
clipboard, we're going to use another serial

Serial:
* Echo commands:
Command server:

* Echo commands:

no

no

NTP:

* Hostname:
* Address:
* Method:
OWTemp :

* Enabled:
1M75/SES5D:
* Enabled:
* ADSEL:
llclock:

* Adjust:

* Show date:
* Date format:

pocl.ntp.org
0.0.0.0
lock up hostname

no

no
o

+00:00:00
no
DD-MM-YY

m

7] Autoserol

Newline

~ | 115200 baud Clear output

monitor. A good choice is PUuTTY in Windows and Linux. Another good choice is netcat in Linux.
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-
@ PuTTY Configuration

==

Category:

H Logging
(- Teminal
Keyboard
Bell
Features

- Window

H Appearance
Behaviour
Translation
Selection
Colours

(= Connection
Data

Basic options for your PuTTY session

Specify the destination you wart to connect to

Serial line Speed
COM4 115200
Connection type:

() Baw () Telnet ) Rlogin ) 8SH @) Serial

Load, save or delete a stored session
Saved Sessions
ESP32COM4

Default Settings

Close window on exit:

(C) Aways  (C) Never (@ Only on clean et

Open ] [ Cancel

-
ﬁ PuTTY Configuration

Category:

[ Session

i ' Logging
Keyboard
Bel
Features
- Window

H Appezrance
Behaviour
Translation
Selection
Colours

- Connection
Data

Options contraling the terminal emulztion

Set various terminal options
Auto wrap mode initially on
[7] DEC Crigin Mode initially on
Implicit CR in every LF
Use background colour to erase screen
[7] Enable biinking text
Angwerback to “E:
PuTTY

Line discipline options

Local echo:

) Auto (@ Force on () Force off

Local line editing:

) Auto (@ Force on () Force off

Remote-controlled printing

FPrinter to send ANS| printer output to:

Maone (printing disabled) -
[ Open J [ Cancel

ﬁ PuTTY Configuration

=)

Category:

[=- Session
. Logging
[=1- Teminal
Keyboard
- Bell

- Features
Window

- Behaviour
- Translation
- Selection
i - Colours
(- Connection

- Proxy

- Telnet

- Rlogin

[t~ 55H

- Serial

Corfigure the appearance of PuTTT"s window

Adjust the use of the cursor
Cursor appearance:

@ Block () Underline
[ Cursor blinks

() Vertical ine

Fort settings
Font used in the teminal window

Font: DejaVu Sans Meno, bold, 12-point

Font guality:
() Antialiased () Non-Antialiased
() ClearType @ Default

Adjust the use of the mouse pointer

[7] Hide mouse pointer when typing in window
Adjust the window border

Gap between text and window edge: 1
[ Sunken-edge border (gighthy thicker)

[ Cpen ] [ Cancel

ﬁ PuTTY Configuration

5----Logging
E Terminal
: - Keyboard
- Bell
i b Features
E Nindow
: - AppEarance
Behaviour
- Selection
- Colours
onnection
- Proxy
- Telnet
- Rlogin
[-55H
- Seral

Cptions controling character set translation
Character set translation on received data
Beceived data assumed to be in which character set
UTF-8 -
(Codepages supported by Windows but not listed here,

such as CPBEE on many systems, can be entered
manualy)

| Treat CJK ambiguous characters as wide
|| Caps Lock acts as Cyrillic switch

Adjust how PuTTY handles line drawing characters

Handling of line drawing characters:

@ Use Unicode line drawing code points
'oor man'’s line drawing [+, -and [}

() Fort has XWindows encoding

() Use fort in both ANS| and OEM modes
() Use fort in OEM mode only

[ Copy and paste line drawing characters as lgqgk

Cancel

Gpen | |

The most important PUTTY settings are:

You can save these settings in a named session.

Click “Open” to make a connection with the clock. -

Select the COM-port assigned to the clock.
Select baudrate 115200, 8 data bits, 1 stop bit, no

parity, no flow control.

Turn on implicit CR in every LF.

Set local echo to “Force on”.

Set local line editing to “Force on”.
If your screen has a high resolution, you may want || = comecon
to select a larger font.

Use the UTF-8 character set.

#2 PuTTY Configuration

Category:

(=) Session

i 5----L\:|ggir|g
=~ Terminal

; - Keyboard
.. Bell

- Features
= Window

- Appearance
- Behaviour
- Translation
- Selection
- Colours

 Deda
- Prooy
- Telnet
Rlogin
S5H

Options controling local serial lines
Select a serial line

Serial line to connect to Com4

Configure the serial line
Speed (baud) 115200
Data bits
Stop bits

Partty

ii_‘m

Fow control

Cancel

en |

2
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i: @ RSSI, disconnected
* status:
0K

DISCONNECTED (6)

Once connected, you can send commands to the clock, like w d (short for wifi dump).

" settings.txt - Notepad oo [ [ settings.bet - Notepad [E= )
File Edit Format View Help File Edit Format View Help
Let's create a text f||e that wifi set ssid "your ssid” . »|||clock set dateformat dmy -
W1Fj set ?aSS¥OESE {ggrlpiiiword c}oct set ﬂate;epmodezgff
H wifi set loca . .1 clock set hourformat
contains the necessary wifi set subnet 255.255.255.0 clock set hourlz yes
. wifi set gateway 192.168.1.254 clock set timesepmode blink
Commands for Settlng up the wifi set dns 1 192.168.1.254 clock set showtemp yes
wj;j set dnsthO.O.OZO =| ||clock set tempformat celsius
wifi set method static
clock. Many schemes are rgb set grad id 1
. . serial set echocmd yes rgb set solid id 17
possible; the commands rgb set sleep raw 0 0 0
cs set echocmd no rgb set method grad
presented here create one . . rgb set grad apply
ntp set hgatngmg 0p801.ntp.org . s
: ntp set addr 0.0.0. main set wificonnect yes
pOSS|bIe SEtUp. ntp set method hostname main set ntprequest yes
main set ntprefresh 01 00 00
owtemp set enabled yes main set cmdsrvstart yes L
— bled main set 51Eeptime 0%60g0080 1
: H m75 set enabled no main set wakeuptime
YUO can flnd a |ISt Of Tm75 set adsel 0 main set sleepmode yes
Commands in a Iater Section_ clock set adjust + 01 00 00 cettings write
clock set showdate yes i -
settings.bxt - Notepad =) COM4 - PuTTY [

File Edit Format View Help

m

(1]

rgh set method grad

0K

rgb set grad apply
wificonnect yes
ntprequest yes
ntprefresh 81 00 06

cmdsrvstart yes

sleeptime 01 00 00

wakeuptime 06 30 00

sleepmode yes

write

When the text file is done, you can transfer it to the serial port in the serial monitor. In the case of
PuTTY, select all text in the editor and copy it to the clipboard. CTRL-C will do the trick. In PuTTY,

press the right mouse button to paste the text from the clipboard.
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The settings will take effect as
soon as the clock receives them.
If the settings are correct, the
clock connects to your local
wireless network, queries the
date and time with the specified
NTP server, and shows the time
on the tubes.

We have to store the settings in
non-volatile memory to
preserve them when the clock is
powered down or reset. We
included command settings write
volatile storage.

The clock software allows a
network client to connect using
port 5010. We can use PuTTY,
netcat, or similar terminal
program to accomplish this.
Once the terminal program has
established a connection with
the clock, you <can send
commands the same way you do
with the serial monitor. Note
that unlike opening the serial
interface, establishing a

EP COM4 - PuTTY

main set cmdsrvstart ;;s
g:in set sleeptime 01 90 00
3§in set wakeuptime 06 30 00
ggin set sleepmode yes

0K

settings write

i event 7 - SYSTEM_EVENT_STA GOT_IP
i status 3 - CONNECTED
192.168.1.141
SYSTEM_EVENT_STA_GOT_IP
CONNECTED
192.168.1.141

i got IP:
i event 7 -
i status 3 -

i got IP:
NTP_Start
DNS_Host_By Name_Init: err -5, pending
DNS Host By Name CB: pool.ntp.org -> IP address 158.43.128.33
NTP query: packet received 48 bytes
* time_t: 1524337235
* UTC: 2018-04-21 19:00:35

n

in our text file so all settings are immediately written to non-

#P 192.168.1.141 - PuTTY

[E=N e

: started (listening)

slot #0: 192.168.1.141:5010 <-> 192.168.1.118:50319
slot #1: not connected

slot #2: not connected

slot #3: not connected

rgb grad id 2
(1]
clock set adjust + 2 0 @

connection over the wireless network won't reset the ESP32-devkitC module.

Besides using a PC, you
can use your
smartphone to send
commands to the clock
over the  wireless
network.

* status: CONI
+local: 192.168.1.141
 Subnet: 255.255.255.0

+ Gateway: 192.168.1.254
*DNS #1: 192.168.1.254
*MAC: 30:AEA405:58:1C
* Hostname: i
+SsID:

+ BSSID:

(3
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Here are the contents of settings.txt. You can copy the text from this document in your own editor
and adjust the settings to your liking.

wifi set ssid "your ssid"

wifi set password "your password"
wifi set local 192.168.1.141

wifi set subnet 255.255.255.0
wifi set gateway 192.168.1.254
wifi set dns 1 192.168.1.254

wifi set dns 2 0.0.0.0

wifi set method static

serial set echocmd yes
cs set echocmd no

ntp set hostname "pool.ntp.org"
ntp set addr 0.0.0.0
ntp set method hostname

owtemp set enabled yes

Im75 set enabled no
1m75 set adsel 0

clock set adjust + 01 00 00
clock set showdate yes

clock set dateformat dmy
clock set datesepmode off
clock set hourformat 24
clock set hourlz yes

clock set timesepmode blink
clock set showtemp yes

clock set tempformat celsius

rgb set grad id 1

rgb set solid id 17

rgb set sleep raw 0 0 O
rgb set method grad

rgb set grad apply

main set wificonnect yes
main set ntprequest yes

main set ntprefresh 01 00 00
main set cmdsrvstart yes
main set sleeptime 01 00 00
main set wakeuptime 06 30 00
main set sleepmode yes

settings write
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Commands

The clock software accepts an extensive list of commands. There are several groups of commands,
each starting with a specific keyword e.g. wifi. Many commands can be abbreviated. For example,
w set m st is short for wifi set method static.

Commands that change a setting have a 2™ keyword called set followed by the actual setting e.g.
wifi set method dynamic. Settings are always changed in RAM. Command s d reports all current

settings in RAM. To make the settings permanent, issue command s w (short for settings write).

Note that the settings command group doesn't change actual settings. These commands manage
the settings as a whole.

The commands are documented and implemented in source file cmd_proc.ino.

Here's a list of recurring parameters. Parameters that are specific to a command are explained with
the command.

Recurring parameters:

IPV4AAD 1IPv4 address, for example: 192.168.1.1
YEAR 1970..2225
MONTH 1..12

DAY 1..31

HOUR 0..23
MINUTE O0..59
SECOND 0..59

RED 0..4095
GREEN 0..4095
BLUE 0..4095

YN yes|y,no|n

Here's a list of all commands.

close Close the command interface (network connection only)
echocmd|ec YN Enable or disable echoing of commands on the command
interface
sys System
L reset System reset
wifi|w Wifi
L start|s Start WiFi
L stoplp Stop WiFi
L dump|d Dump information
L set Settings
L ssid "..." Specify the SSID, network name (max. 32 characters)
L password "..." Specify the password (max. 63 characters)
L local IPV4AD Static IPv4 local address
L subnet IPV4AD Static IPv4 subnet mask
L gateway IPV4AD Static IPv4 gateway address
L dns NUMBER IPV4AD Static IPv4 DNS address (NUMBER=0..1)
L method|m Method of assigning IPv4 address
L dynamic|dyn Use DHCP
L static|st Use static address
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serial |ser
L set
L. echocmd|ec YN

cmdsrv|cs

Serial interface
Settings

Enable or disable echoing of commands on the command

interface

Command server

L start|s Start the command server
L stoplp Stop the command server
L dump|d Dump information
L closelc
L all Close all client connections
L. INDEX Close specific client connection (INDEX=0..3)
L set Settings
L echocmd|ec YN Enable or disable echoing of commands on the command
interface
ntp NTP
L start|s Start NTP request
L set Settings
L method|m Method of determining IPv4 address of NTP server
L hostname|h Use hostname for looking up IPv4 address
L addr|a Use IPv4 address
L hostname "..." Hostname of NTP server
L. addr IPV4AD IPv4 address of NTP server
owtemp 1-Wire temperature sensor
L set Settings
L. enabled|ena YN Enable or disable temperature sensor
1m75 | se95d I°C temperature sensor
L set Settings
L. enabled|ena YN Enable or disable temperature sensor
L adsel N Specify A[2..0] pin configuration of the chip (N=0..7)
clock|c Clock

L write|w YEAR MONTH DAY HOUR MINUTE SECOND
Write date and time
Read current date and time

read|r
suspend
resume
set

rrrr

Suspend the clock
Resume the clock
Settings

L adjust [N] +|- HOUR MINUTE SECOND

showdate|sd YN

selectadjust|sa N

Adjustment applied on time received from NTP server

(multiple adjustments, N=1..4,

Select adjustment
Show date y/n

(N=1..4)

rrr

rrr

dateformat|df dmy|mdy|ymd

datesepmode |dsm on|off

hourformat|hf 12|24
hourlz | hlz YN

Hour format:

Date format:

dmy=day-month-year,
mdy=month-day-year,
ymd=year-month-day

on=always on
off=always off

timesepmode | tsm blink|ampm|on|off

showtemp | st YN

12=12-hour format,
Show hour with leading zero y/n

blink=blink ones per second,

ampm=indicate AM/PM,
on=always on,
off=always off

Show temperature y/n

tempformat|tf celsius|c|fahrenheit|f

Temperature format

Page 29 of 38

default is 1)

Mode of separator tubes when showing date:

24=24-hour format

Mode of separator tubes when showing time:



display|d
L suspend

Display driver
Suspend the display driver

L resume Resume the display driver
rgb RGB driver
L solid|s Select solid RGB colors
L id N Select scheme from list (N=0..17)
L raw RED GREEN BLUE Specify RGB values
L gradl|s Select animated gradient colors
L id N Select scheme from list (N=0..5)
L set Settings
L method|m Color method
L solid|s Use solid RGB colors
L grad|g Use animated gradient colors
L solid|s Solid RGB colors
L id N Select scheme from list (N=0..17)

L. raw RED GREEN BLUE
L use

Specify RGB values
Copy active solid RGB colors to settings

L apply Apply solid RGB colors in settings as active
L grad|g Animated gradient colors
L id N Select scheme from list (N=0..5)
L use Copy active gradient colors to settings
L apply Apply gradient colors in settings as active
L sleep Solid RGB colors shown during sleep mode
L id N Select scheme from list (N=0..17)
L raw RED GREEN BLUE Specify RGB values
L use Copy active solid RGB colors to settings
L apply Apply solid RGB colors in settings as active during
sleep mode
main|m Main function
L ntprefresh|nrf Perform an NTP request and refresh clock date and time
L set Settings
L wificonnect|wc YN Automatically connect to wireless network y/n
L ntprequest|nrqg YN Periodically perform an NTP request y/n
L ntprefresh|nrf HOURS MINUTE SECOND
NTP refresh period (HOURS=0..255)
L cmdsrvstart|css YN Automatically start command server y/n
L sleeptime|st HOUR MINUTE SECOND
Time to go to sleep
L wakeuptime |wut HOUR MINUTE SECOND
Time to wake up
L sleepmode|sm YN Enable or disable sleep mode

settings|s
L write|w
L read|r

L reset
L clear
L dump|d

Settings

Write settings from RAM to EEPROM

Read settings from EEPROM to RAM, verify, apply
default settings if invalid

Reset settings in RAM

Clear settings in EEPROM

Dump information

The number of rgh commands is extensive. This is because the software manages two sets of RGB
data, one for settings and one for activity (colors actually being shown). An early version of the
software had one data set, but this design led to confusion when one was updating settings while
fiddling with the RGB colors. So it was decided to split up the RGB data into two data sets.

The diagram below shows how the various rgb commands influence the data sets. Each command
induces a data flow through the associated arrow(s).

The active set stores a copy of the initial gradient colors since the colors and thus the data values
are constantly changing when the animated gradient color method is active.
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Settings Data

rgb set method ——P

method

rgb set grad id —p

gradient
colors

rgb set grad apply

Active Data

method

rgb set sleep id

rgb set sleep raw

solid colors
sleep mode

rgb set grad use

rgb set sleep apply

initial
gradient
colors

rgb set solid id

rgb set solid raw

solid colors

rgb set sleep use

rgb set solid apply

gradient
colors

rgb set solid use

solid colors

rgb grad id

rgb solid id

rgb solid raw




Time Adjustments

The clock receives date and time from an NTP server as Coordinated Universal Time (UTC). The
NTP protocol supplies no information about time zones or daylight saving time (DST). To display
the time correctly for your physical location, the clock software adds or subtracts a time offset to
or from the displayed time and date. This is called time adjustment.

The data set for time adjustment consist of hours, minutes, seconds and a flag that indicates
addition or subtraction.

The clock software maintains four time adjustment data sets. There are two commands for
managing time adjustment, clock set adjust and clock set selectadjust. The former sets up a time
adjustment data set, the latter select the active data set.

In addition, the push button on the back panel can be used for controlling the active adjustment.
When you hold down the button for a couple of seconds, the tubes display the active adjustment,
a value ranging from 1 to 4. By holding down the button a bit longer, the value cycles through its
range until you release the button. Once the value changes, a new time adjustment comes into
effect, and as soon as the button is released the clock settings are written to non-volatile memory
(all settings are written, it's the same action as command settings write).

To adjust for a timezone, one data set is required. Daylight saving time requires an additional data
set. For example, when your timezone is UTC+1, you can adjust the displayed time with these
commands:

clock set adjust1+100

clock set selectadjust 1

To support daylight saving time in this timezone, use a second data set. For example, if your
location is timezone UTC+1 and it's the winter months, issues these commands:

clock set adjust1+100

clock set adjust2+200

clock set selectadjust 1

When daylight saving time starts, you can hold the push button to change to data set number two.

When daylight saving time ends, hold the push button once again to change back to data set
number one.
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Assembling the Enclosure

©

Remove the protective finish from the baseplate and the acrylic support. Mount the rubber feet on
the bottom at the backside using two M3x5 machine screws. The holes are pre-threaded with an
M3 thread. Do not exert too much force as the screw ends should not protrude on the other side

of the base plate.

Mount the acrylic stand to the baseplate using an M3x12 machine screw and an M3 nut. Do not
overtighten the screw as the acrylic may break.

Screw two M3x8 machine screws all the way from the bottom side through the baseplate and slide
two 3 mm spacers over the screw ends on the top side.

Remove the protective finish from the front panel. Attach two 8 mm M3 F/F plastic spacers to the
front panel using two M3x6 machine screws.

Slide the front panel over the IV-22 and DM160 tubes of the clock assembly and attach it to the
display PCB using another set of two M3x6 machine screws.
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Position the main PCB on top of the baseplate so
it fits over the earlier installed M3x8 screws and
3 mm spacers. Make sure the tabs on the front
panel fit into the slots of the baseplate.

Attach the main PCB to the baseplate using four
M3x8 machine screws and four 3 mm spacers.

Remove the protective finish from the side panels. Look for the correct orientation and attach
them to the baseplate using an M3x12 machine screw and an M3 nut. Do not overtighten the
screws.
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Cut two 5 cm pieces of the 0.5 mm? red and black wire. Strip the ends and solder the wires to the
power connector and the push button. Insulate the solder joints using 1.5 cm pieces of 3.2 mm
heat shrink tubing. Do not tin the other ends of the wires that will go into the terminal blocks on

the main PCB.

Remove the protective finish from the back panel and attach the power connector using two M2x6
machine screws and two M2 nuts. Watch the orientation of the panel so the wires protrude at the
right side. Attach the push button to the back panel. A 10mm socket will come in useful here, if not
pliers will do the job. If you decide to use pliers, be careful not to scratch the acrylic.

Connect the wires to the terminal blocks on the
main PCB. Watch the polarity of the power
connector. Insert the tabs of the back panel into
the slots of the baseplate.
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Remove the protective finish from the top panel and fit it over the front, back and side panels.
Attach it to the side panels using two M3x12 machine screws and two M3 nuts. Do not overtighten

the screws and be careful not to drop the M3 nuts inside the enclosure.

Congratulations!!! Your clock is complete now.
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Assembling the Temperature Sensor

/"

Slide the three pre-crimped wires into the 3-pole female connector from the backside until they
snap into place.

BOTTOM VIEW

DS18B20 To-92
Package

PIN ASSIGNMENT

3

Slide 2 cm pieces of 3.2 mm heat shrink tube over the wires and solder the wires to the DS18B20
sensor. The wire marked with “1” on the female connector is the +5 V power supply. The middle

wire is DQ (1-Wire data). The remaining wire is ground (GND). Please take a look at the DS18B20
pinout in order to connect the wires correctly.
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Crimp the heat shrink tube using a heat source, slide a 2 cm piece of 6.4 mm heat shrink tube over
the sensor and shrink again. The sensor is now ready to use.

Connect the temperature sensor to K6 on the
main PCB of the clock. Do not forget to enable
the sensor in the software settings.
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